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What is VOFAplotter? 

VOFAplotter is a cutting-edge NinjaTrader 8 indicator that combines the proven 
principles of Volume Spread Analysis (VSA) with advanced price action logic to 
automatically identify high-probability market turning points. It reads the language of 
price, spread, and volume together — revealing the footprints of professional traders 
and smart money on any market and any timeframe. 
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1. Introduction to VOFAplotter 

 

VOFAplotter is built on decades of market research rooted in the Wyckoff Method and Volume Spread 
Analysis, delivering institutional-grade market insights directly on your NinjaTrader chart. 

 

Who Is This Indicator For? 

• Day traders and swing traders seeking confirmation before entering trades 

• Traders who want to understand what institutional and professional money is doing 

• Anyone who wants to avoid trading against the trend of smart money 

• NinjaTrader 8 users on any instrument — Futures, Forex, Stocks, Crypto 

 

Key Capabilities 

Feature Benefit 

Automatic bar coloring Instantly understand the quality of each bar 

VSA pattern detection Spot professional buying and selling zones 

Support & Resistance lines Auto-drawn from significant price levels 

Supply & Demand zones Visible rectangles showing high-interest 
areas 

Trade alert system Audio + on-chart messages at trigger points 

Session-based signals End-of-session setups for next-day trading 

Works on all timeframes From 1-minute scalping to daily swing 
trading 

 

NO REPAINT  VOFAplotter does not repaint. All signals are calculated on bar close, giving you 
reliable, stable analysis you can trust. 
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2. What is Volume Spread Analysis (VSA)? 

 

Volume Spread Analysis is a methodology developed from the original work of Richard Wyckoff in the 
early 1900s and later refined by Tom Williams. VSA reads three pieces of information on every single 
bar: 

 

VOLUME SPREAD CLOSE POSITION 

The total activity on the bar 
— represents the effort put 
in by all participants 

The range from High to Low 
— represents the result of all 
that effort 

Where price closed relative 
to the bar's range — reveals 
who won control 

 

The Core Principle: Effort vs. Result 

The most fundamental concept in VSA is the relationship between effort (volume) and result (spread + 
close). When these are in harmony, the trend is healthy. When they diverge, a turning point is likely 
near. 

 

KEY INSIGHT  High Volume + Narrow Spread = Effort without result. This is the hallmark of 
professional absorption — the market is being controlled and a reversal may be imminent. 

 

VSA recognizes that financial markets are driven by two groups of participants: 

 

Professional / Smart Money Retail / Public Money 

Banks, institutions, hedge funds Retail traders, general public 

Accumulate silently over time React to news and emotions 

Move markets when ready Often enter too late or too early 

Leave footprints in volume & spread Visible through erratic price swings 

 

VOFAplotter automatically scans every bar for these footprints and colors them accordingly — so you 
always know whose hands are in the market. 
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3. Core VSA Concepts Decoded 

 

VOFAplotter encodes the following professional VSA concepts into its analysis engine. Each concept 
represents a specific market condition that professionals use to time entries and exits. 

 

3.1  Effort vs. Result (EVR) 

Effort vs. Result is the foundation of VSA. Every bar is evaluated by comparing the energy (volume) 
expended versus the price movement (spread) achieved. 

 

• Normal EVR: Volume and spread both increase together — trend is healthy 

• EVR Divergence: Volume increases but spread contracts — smart money is absorbing supply 
or demand 

• Hidden EVR: Volume stays flat but spread expands significantly — professional interest is low, 
move may be unsustainable 

 

3.2  Buying Climax 

A Buying Climax occurs when the market has been rising and professional operators take the 
opportunity to unload their holdings into enthusiastic retail buying. This is one of the most reliable signs 
of an impending top. 

 

BEARISH SIGNAL  Characteristics: Ultra-high volume, wide spread, bar closes in upper 
portion, new high made. The public rushes in — professionals quietly sell. 

 

• Type 1 Buying Climax: Maximum strength version — spread is 4x or more the average, ultra-
high volume, fresh high 

• Type 2 Buying Climax: Moderate version — spread is 2x to 4x average, confirming professional 
distribution 

• Type 3 Buying Climax: Price revisits a prior climax zone with reduced spread — a second 
chance to distribute 

. 

 

3.3  Selling Climax 

The mirror image of a Buying Climax. Selling Climaxes occur at market bottoms when panicking retail 
traders dump positions into professional accumulation. 

 

BULLISH SIGNAL  Characteristics: Ultra-high volume, wide spread, bar closes in lower portion, 
new low made. The public panics — professionals quietly buy. 

 

• Price makes a fresh 30-bar low on ultra-high volume with a wide spread 
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• Close is in the lower half — showing apparent weakness, but professionals are absorbing 
supply 

• When a new 25-bar low is also confirmed, an additional marker highlights the significance 

 

3.4  Upthrust (Supply Entering the Market) 

An Upthrust is a professional trap — price is briefly pushed above a prior high to trigger retail buy 
orders and stop-outs, only to reverse sharply back down. Smart money uses this to exit long positions 
or initiate short trades. 

 

• Classic Upthrust: Wide spread bar with close in the lower half in an uptrend — the spread is 
wide but price cannot hold its gains 

• Pseudo Upthrust: Following an ultra-high volume bar, price makes a new high but closes back 
in the lower half with decreasing volume 

• Confirmed Upthrust: A bar that follows an upthrust and closes lower, confirming supply has 
entered 

• Upthrust Type 3: Wide spread, high volume, close below midpoint, new high but not a new low 
— a refined distribution signal 

 

PATTERN LOGIC  VOFAplotter automatically chains upthrust patterns into multi-bar 
sequences, only signalling when all confirmation criteria are met across the pattern. 

 

3.5  No Supply 

No Supply is a bullish condition where a down bar on narrow spread and low volume (lower than the 
two previous bars) appears within a broader uptrend context. This tells you that supply — the selling 
pressure — has dried up. The market is ready to move higher. 

 

• Narrow spread down bar — sellers are not committing 

• Volume is less than the previous two bars — no real selling pressure 

• Occurs after ultra-high volume or wide spread bars — confirming the original upside interest 

 

3.6  No Demand 

No Demand is the bearish counterpart to No Supply. An up bar on narrow spread and low volume 
signals that buyers are not interested in pushing price higher. The market is likely to turn lower. 

 

• Narrow spread up bar — buyers have no conviction 

• Two-day low volume — participation is absent 

• Close in lower half of bar — buying attempt failed 

 

3.7  Supply Test 
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A Supply Test occurs when price dips below a previous low on low volume, then closes back up near 
the high of the bar. This is the market testing whether any remaining sellers are still present. When 
volume is low on this test, it confirms no supply exists — a powerful buy signal. 

 

• Price probes below a prior support level 

• Volume is significantly below average — sellers are gone 

• Bar closes in the upper half — buyers step in immediately 

• When found in a confirmed uptrend, this is one of the highest-probability buy setups in VSA 

 

3.8  Distribution 

Distribution occurs when professional money is transferring ownership of assets to the retail public at 
elevated prices. VOFAplotter identifies distribution through specific bar formations where ultra-high 
volume appears but price makes limited upward progress. 

 

• Ultra-high volume (4x average) on a narrow-to-average spread bar 

• Price makes a new 5-bar high but closes in the lower half 

• Occurs after an uptrend — professionals are filling their short books while retail buys 

 

3.9  Effort Up Move & Effort Down Move 

These patterns confirm momentum in the direction of the trend: 

 

• Effort Up Move: Bar closes above prior bar's high and low, with a high close, wide spread, and 
increasing volume — genuine demand is present 

• Effort Down Move: Bar closes below prior bar's high and low, with a low close, wide spread, and 
increasing volume — genuine supply is present 

• A failed Effort Up Move (followed immediately by an Upthrust) is especially significant — the 
effort failed and reversal is very likely 

 

3.10  Shakeout 

A Shakeout is a deliberate move by professionals to flush out weak retail holders before a genuine 
move in the opposite direction. Price pierces a key level, stops out retail traders, then snaps back 
sharply. 

 

• Price breaks below a prior bar's low on high volume 

• The wide spread signals the apparent panic 

• The bar closes well above the low — the break was absorbed immediately by professionals 

• The following bar confirms by closing in the upper half within the shakeout bar's range — a 
Cyan bar signal 
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4. Bar Color Guide 

 

VOFAplotter communicates its analysis by painting each bar a specific color. Learning these colors is 
the fastest way to read the market at a glance. Each color maps to a specific VSA condition. 

 

Color Bar Name What It Means 

 Blue Ultra-high volume bar (2.8x the 14-period average). Strong institutional 
activity present. Key turning point candidate. 

 Purple High volume bar (1.5x the 30-period average). Elevated professional 
interest. Monitor for follow-through. 

 Indigo Classic ultra-high volume spike (2.5x the 30-period average). Maximum 
professional footprint. Watch very carefully. 

 PaleVioletRed EVR (Effort vs Result) divergence. Volume increased but spread 
contracted — supply absorbed or demand absorbed. 

 Gray Decreasing volume trend bar. Three consecutive bars of reducing 
volume after a spike — energy is fading. 

 Yellow Ninja Pattern — a down bar in the upper range of a prior wide-spread up 
bar, or vice versa. Reversal setup forming. 

 Cyan Trap or Shakeout bar. Price breached a key level but snapped back — 
professionals absorbed the fake break. 

 Orange / 
DarkOrange 

Wide spread, high volume bar with close in upper zone. Demand is very 
strong — momentum bar. 

 White (half-
blue/half-
white) 

Rendered pattern bar. Top half Blue, bottom half White — signals an 
EVR divergence bar within context. 

 

PRO TIP  Tip: When you see an Indigo or Blue bar, do not trade immediately in its direction. 
Wait for confirmation on the next 1-3 bars. These high-volume bars often precede reversals. 

 

Bar Color Priority 

When multiple conditions are met simultaneously, VOFAplotter applies colors in the following priority 
order: 

1. Very Narrow Spread (Gray) — overrides all others when spread is extremely tight 

2. Yellow (Ninja Pattern) — high-priority reversal setup 

3. Cyan (Trap/Shakeout) 

4. Blue (Ultra-High Volume — 2.8x) 

5. Purple (High Volume — 1.5x) 

6. Indigo (Classic Ultra-High Volume — 2.5x) 

7. PaleVioletRed (EVR Divergence) 

8. Gray (Decreasing Volume) 
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5. Signal & Pattern Reference 

 

VOFAplotter identifies and marks the following multi-bar patterns on your chart. Each pattern requires a 
sequence of specific conditions to be met before a signal fires — eliminating low-quality entries. 

 

5.1  End-of-Session Buy Setup  

This pattern identifies professional accumulation at session endings — one of the highest-probability 
setups in the indicator. 

 

How it works: On the last bar of the session, the indicator evaluates the second-last bar and last 
bar If Bar 1 shows a wide spread with a low close, and Bar 2 is contained within Bar 1's lower 
range on smaller spread, a dashed white line is drawn from Bar 2's high and low into the next 
session. 

 

Entry Trigger 

• The next session must open at or above the upper line  

• Price then touches the upper line during that session 

• On touch: an on-chart BUY message fires with Entry, Stop-Loss, and Target levels 

 

5.2  End-of-Session Sell Setup  

The mirror image of the Buy Setup, identifying professional distribution at session endings. 

 

How it works: Bar 1 must close in the upper half of its range on wide spread. Bar 2 must be 
contained in the upper area of Bar 1 on reduced spread. Two dashed lines are drawn from Bar 
2's high and low into the next session. 

 

Entry Trigger 

• The next session must open at or below the lower line  

• Price then touches the lower line during that session 

• On touch: an on-chart SELL message fires with Entry, Stop-Loss, and Target levels 

 

5.3  Ultra High Volume Activity Setup 

When two consecutive session-ending bars both show ultra-high volume on similar spread and range, 
the indicator marks both bars with lines extending into the next session. These levels represent 
significant institutional interest zones. 

 

• Both bars must have volume at least 3x the 20-bar average 
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• Spreads must be within the average range — eliminating pure volatility spikes 

• The two bars must be in range with each other  

• Lines are drawn from the highest high and lowest low of the pair 

 

 

 

5.4  Gray Bar with Consecutive Highs/Lows 

After three or more consecutive higher highs or lower lows, a Gray bar (decreasing volume) triggers a 
potential reversal signal: 

 

• After 3+ higher highs: Gray bar closing in lower half = potential sell signal 

• After 3+ lower lows: Gray bar closing in upper half = potential buy signal 

• The bar following the gray bar further confirms if it's a special-color bar closing against the prior 
trend 
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6. Zone Drawing Features 

 

VOFAplotter automatically draws demand and supply zones on your chart whenever specific high-
volume, wide-spread conditions are met. These zones highlight price areas where professionals 
previously engaged heavily — and are therefore likely to engage again. 

 

6.1  Primary Supply / Demand Zones 

• The zone spans from the High to the Close (bullish close) or Low to Close (bearish close) 

• Zone is drawn in Light Gray and extends 2 days forward automatically 

• After 2 days, the zone continues until price touches it 

• When price returns to touch the zone, it changes color to Orange — signaling a potential 
reaction 

 

6.2  Secondary Supply / Demand Zones 

• Zone drawn in Light Blue — softer interest level 

• Same extension and touch logic as Primary zones 

• Touch changes color to Red — watch for reaction 

 

6.3  Ultra Wide Spread Pattern Zones 

When a single bar has a wide spread AND closes in the upper or lower half of its range, it is flagged as 
an Ultra Wide Spread bar. If the very next bar is narrow and contained within the correct area, a 
horizontal zone is drawn at Bar 2's range. 

 

• Phase 1 (first 2 days): Zone is forced to remain visible regardless of touches 

• Phase 2 (after 2 days): Zone disappears on first touch — zone becomes Orange 

• This zone marks the "reaction point" where professionals tested the market after the wide-
spread move 

 

6.4  Zone Transparency 

All zones support adjustable transparency through the Zone Transparency parameter (0–100). Set to 
30 by default, giving zones a subtle presence without obscuring the bars behind them. 

TIP  Recommended: Keep Zone Transparency between 20–50. Too low makes zones opaque 
and blocks chart view. Too high makes them invisible. 
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7. Support & Resistance Lines 

 

VOFAplotter automatically draws dynamic support and resistance lines from statistically significant 
price levels. These are not arbitrary pivot lines — they are derived from fresh multi-session extremes 
that have been confirmed by a 3% pullback or rally. 

 

7.1  Resistance Lines 

• A new resistance candidate is created when price makes a fresh high  AND the current bar high 
exceeds the previous bar high 

• The candidate remains active until a pullback from the high is observed — confirming the level 
is genuine resistance 

• On confirmation, a dashed horizontal line is drawn from the candidate bar  

• Line color is determined by the color of the candidate bar or the bar before it (Indigo, 
PaleVioletRed, or Orange bars get matching line colors) 

• The line ends (finalizes) on the first price touch after creation 

 

7.2  Support Lines 

• Mirror logic of resistance: fresh low with a lower low than the previous bar 

• A  rally from the low confirms the support level 

• Dashed line drawn forward — color matches the candidate bar's VSA color 

• Finalized on first touch 

 

COLOR CODING  These lines are color-coded to match the bar that created them — giving you 
instant context about whether the level was formed on a high-volume institutional bar 
(Indigo/Blue) or a divergence bar (PaleVioletRed). 
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8. Trade Alert System 

 

VOFAplotter includes a comprehensive alert system that notifies you with audio sounds and on-chart 
text messages when trade setups trigger. All alerts are session-aware and only fire during the 
confirmed eligible session. 

 

8.1  Alert Types 

Alert Name Trigger Condition Default Sound 

Buy Alert Price touches upper session 
line in eligible session 

Alert1.wav 

Sell Alert Price touches lower session 
line in eligible session 

Alert1.wav 

BuySignal (intraday) Green Dot pattern fully 
confirmed 

Alert1.wav 

SellAlert (intraday) Sell Dot pattern fully confirmed Alert2.wav 

 

8.2  On-Chart Trade Messages 

When a session-based setup triggers, a text box appears on the chart anchored to the Bar 1 position, 
showing: 

 

BUY at 21,450.00 SL 21,385.00 TARGET 21,645.00 

 

For SELL setups, the message appears above Bar 1 and shows the short entry, stop above the 
structure, and target below. 

 

8.3  Alert Settings 

Setting Default Description 

Show trade messages On Display entry/SL/target text on chart 

Enable alerts On Fire NinjaTrader audio + popup alerts 

Touch tolerance (fraction) On How close price must come to line to 
trigger  

Alert Sound Alert1.wav Sound file played on signal 
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9. Settings & Parameters 

 

Access all settings by right-clicking the chart > Indicators > VOFAplotter. The following parameters 
control indicator behavior. 

 

9.1  Parameters Group 

Parameter Type Default Description 

Show Signals on Chart Bool True Show/hide all dots and triangle markers 

Remove Bars from Chart Bool False Make all bar colors transparent (overlay 
mode) 

Zone Transparency 0–100 30 Controls opacity of all horizontal zone 
rectangles 

Alert Sound String Alert1.wav Sound file name for alert notifications 

 

9.2  Trade Alerts Group 

Parameter Type Default Description 

Show trade messages Bool True Show BUY/SELL text boxes on chart at 
signal bars 

Enable alerts Bool True Emit NinjaTrader audio and popup alerts 

Touch tolerance (fraction) Decimal 0.0002 Tolerance band for session line touch 
detection 
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10. Installation & Setup 

 

10.1  System Requirements 

• NinjaTrader 8.1 or later 

• Windows 10 or Windows 11 

• Any market data provider connected to NinjaTrader 8 

• Minimum 4 GB RAM recommended 

 

10.2  Installation Steps 

9. Download the VOFAplotter .cs file provided after purchase 

10. Open NinjaTrader 8 

11. Go to Tools > Edit NinjaScript > Indicator 

12. In the NinjaScript Editor, go to File > New and paste the indicator code, OR go to File > Import 
NinjaScript and select the provided file 

13. Click Compile (F5) — you should see 0 errors in the output window 

14. Close the editor 

15. On any chart, right-click > Indicators > find VOFAplotter under the Paratrade folder 

16. Click Add, then OK 

 

10.3  Recommended Chart Settings 

Chart Setting Recommended Value 

Calculate On Bar Close 

Minimum bars lookback 256 or higher 

Timeframe 5 min, 15 min, 1 Hour, or Daily 

Show Signals on Chart True (to see all markers) 

Zone Transparency 30 (default) 

 

LICENSE NOTE  Important: VOFAplotter includes a device license check. It must be activated 
on your licensed machine. Contact Paratrade support if you receive a license error. 
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11. Best Practices 

 

11.1  Reading Bar Colors in Context 

• Never trade a single bar color in isolation — always look at the context of the last 5–10 bars 

• An Indigo (ultra-high volume) bar in the middle of a trend is a caution signal, not an automatic 
reversal 

• Multiple consecutive PaleVioletRed bars show sustained EVR — the market is absorbing 
without committing 

• A Gray bar after a series of colored bars is a strong signal — energy is genuinely exhausting 

 

11.2  Using Zones for Entries 

• Wait for price to return to a zone rather than chasing the move 

• When price enters a zone and the bar color is Cyan or Gray, this is a high-probability setup 

• Combine zone touches with end-of-session line alerts for the highest quality trades 

 

11.3  Timeframe Recommendations 

Trading Style Primary Timeframe Confirmation Timeframe 

Scalping 1–3 Minute 5 Minute 

Day Trading 5–15 Minute 1 Hour 

Swing Trading 1 Hour Daily 

Position Trading Daily Weekly 

 

11.4  Risk Management 

DISCLAIMER  VOFAplotter provides signals and context — it does not guarantee profits. 
Always use proper stop-loss orders. The provided Entry/Stop/Target levels are suggestions 
based on VSA logic. Adjust them to your own risk tolerance. 

 

• Always use the provided Stop-Loss levels from the alert messages 

• Risk no more than 1–2% of your account per trade 

• Take partial profits at 1:1 and let the remainder run to the 3:1 target 

• Do not override signals with emotion — VSA is probability-based, not certainty 
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12. Frequently Asked Questions 

 

Does VOFAplotter repaint signals? 

No. All signals are calculated on bar close using the Calculate = OnBarClose setting. Once a bar closes 
and is colored, that color will not change. 

 

What markets does it work on? 

VOFAplotter works on any instrument available in NinjaTrader 8 with volume data — including Futures 
(ES, NQ, CL, GC), Forex, Stocks, ETFs, and Cryptocurrencies. Volume-based analysis is most reliable 
on Futures markets where tick volume represents actual contracts traded. 

 

Can I use it on multiple timeframes? 

Yes. Add VOFAplotter to as many chart windows as you need. Each instance operates independently 
on that chart's timeframe and instrument. 

 

Why do I see some bars with no color change? 

Not every bar will be colored. Only bars that meet specific VSA conditions receive a special color. Plain 
candlestick-colored bars represent normal activity that does not meet the threshold for any VSA signal 
— which is perfectly normal. 

 

The alert says BUY but the trade didn't work — why? 

No indicator produces 100% win-rate signals. VSA provides high-probability setups, not certainties. 
Always use the provided stop-loss. Over a series of trades, the edge becomes statistically significant. 

 

How do I change the Zone Transparency? 

Right-click chart > Indicators > VOFAplotter > Parameters group > Zone Transparency. Enter a value 
between 0 (fully opaque) and 100 (invisible). Click OK or Apply. 

 

I received a license error — what do I do? 

The indicator is licensed to a specific machine. If you have changed computers or reinstalled Windows, 
contact Paratrade support with your order details for re-activation. 

 

Can other indicators access VOFAplotter data? 

Yes. VOFAplotter exposes a BarValue series and a SignalSeries that can be accessed by other 
NinjaTrader indicators and strategies. Contact Paratrade for integration documentation. 
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Thank you for choosing VOFAplotter by Paratrade. 

For support, updates, and training resources, visit us at your purchase portal. 

Trade smart. Trade with the professionals. 


